MODUL PRAKTIKUM
KOMUNIKASI LORA NODE DAN GATEWAY

1. TUJUAN
a. Melakukan konfigurasi pada LoRa node dan LoRa gateway
b. Melakukan komunikasi antar LoRa dengan pengiriman data

C.

Mengetahui nilai RSSI dan SNR yang didapat dari komunikasi

2. DASAR TEORI
2.1. Long Range (LoRa)

LoRa (Long Range) adalah suatu format modulasi yang dibuat oleh Semtech.
LoRa merupakan teknologi nirkabel berdaya rendah yang menggunakan
spektrum radio. LoRa mempunyai beberapa kelebihan salah satunya bisa
mengakomodasi jarak mencapai 1 km lebih dengan pengaturan yang tepat dan
juga lingkungan yang mendukung. Teknologi LoRa ini menjadi keuntungan
tersendiri pada perkembangan teknologi seperti WSN yang membutuhkan
pengiriman data yang tahan terhadap noise, konsumsi daya kecil dan dapat
mengakomodasi jarak sensor node dan gateway yang jauh.
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Gambar 1. Sistem Long Range

LoRa merupakan suatu proses perubahan suatu gelombang periodik
tertentu sehingga menjadikan suatu sinyal yang mampu membawa suatu
informasi. Gelombang periodik adalah merupakan gerak gelombang yang secara
teratur. Perubahan gelombang ini teratur dan berulang-ulang yang mempunyai
sumber berupa gangguan yang bertahap atau secara bertahap yang berupa
getaran.

Proses perubahan suatu gelombang periodik itu disebut modulasi. Modulasi
yang dihasilkan pada Lo-Ra menggunakan modulasi FM. Dengan proses
modulasi ini suatu informasi atau biasanay informasi yang berfrekuensi rendah
bisa dimasukkan ke dalam suatu gelombang pembawa. Pada pemrosesan intinya
(modulasi) dihasilkan gelombang frekuensi yang stabil.



Selain dengan metode transmisi metode lain juga bisa digunakan dalam
proses ini. Seperti juga bisa menggunakan PSK (Phase Shift Keying), FKS
(Frequency Shift Keying) dan banyak lagi yang lainnya.

Nilai frekuensi pada masing-masing yang dimiliki Negara atau daerah
berbeda-beda. Seperti di Negara bagian Asia mempunyai frekuensi yang
digunakan yaitu 433 MHZ. Lalu di Negara bagian Eropa mempunyai frekuensi
yang digunakan yaitu 868 MHZ. Kemudian di Negara Amerika Utara mempunyai
frekuensi yang digunakan yaitu 915 MHZ.

Fitur-fitur yang tersedia pada LoRa adalah:

v" Geolocation, fungsi ini dapat memungkinkan mendeteksi lokasi keberadaan
suatu benda tanpa biaya.

v’ Biayanya rendah, biaya rendah karena dapat dengan mudah mengurangi
biaya infrastruktur, biaya operasional dan sensor-sensor yang mengurangi
biaya sendiri.

v" Berstandar, karena dibuat supaya dapat berinteraksi dan terhubung dengan
fungsi produk dan sistem yang lain. Supaya dapat dengan cepat beradaptasi
dengan jaringan dan amplikasi IoT. Amplikasi IoT adalah amplikasi atau
sesuatu hal yang baru di dunia teknologi sensor sehingga dunia akan akan
semakin otomatis.

v Daya baterai rendah, hanya dengan membutuhkan daya baterai sekitar
13Ma sampai 15Ma. Maka baterai akan bertahan lama dari 10 hingga 15
tahun.

v’ Jarak wifinya sangat jauh, satu unit LoRa dapat memancar sejauh 100km.

v’ Kapasitas sangat tinggi, sangat cocok digunakan untuk operator jaringan
yang melayani banyak pelanggan. Hal ini karena mendukung jutaan per base
station.

. LoRaWAN

Modul LoRaWAN yang digunakan adalah modul arduino LoRa Antares
berbasis arduino pro mini (ATMEGA328P).
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Gambar 2. LoRaWAN
LoRa ini dihubungkan pada PC atau laptop dengan menggunakan kabel data
USB. Spesifikasi dari LoRaWAN tersebut sebagai berikut:
Lora Chip : RFM95 915MHz
Supporting Frequency : 915-925MHz
Antenna: 3 dBi



2.3.

2.4.

2.5.

LoRa Gateway ANTARES

Tujuan ANTARES adalah untuk mempercepat waktu pemasaran aplikasi
karena pengguna tidak perlu berinvestasi di cloud infrastructure and API
backend.

Antares berhubungan erat dengan pengembang aplikasi dengan zero
infrastructure management. Itu artinya pengembang tidak perlu menyediakan
infrastruktur cloud ataupun domain. Juga fungsi control device dalam berbagai
brand.

Antares memungkinkan Anda melakukan data analytics platform. Selain itu,
ANTARES terhubung dengan connectivity provider seperti GSM, LTE, LoRa dan
lainnya. Bagi pabrikan peralatan elektronik, ANTARES menyediakan device
manufacturer agar dapat mendaftarkan tipe-tipe device mereka di Antares.

Dengan kemampuan manajemen data, manajemen pengguna dan widget
sederhana, ANTARES menawarkan solusi yang aman karena semua komunikasi
dikirim melalui jalur terenkripsi. Layanan yang tersedia dapat diandalkan secara
real time dan aman.

Perangkat Bahasa pemrograman yang didukung ANTARES meliputi
Arduino, ESP, Android, Raspberry Pi, Orange Pi, Node Red dan lain sebagainya.
Sistem yang Open API memungkinkan pengguna mengontrol aplikasi tak hanya
lewat dasbor tapi juga API yang disediakan oleh ANTARES.

Dengan adanya platform Antares, infrastruktur yang disimpan oleh
developer ke dalam server akan diatur oleh Antares sehingga mereka dapat
memfokuskan diri pada ide dan layanan aplikasi yang mereka ciptakan. Hal ini
merupakan bentuk dukungan sinergis yang dibangun Telkom demi memberikan
pengalaman digital terbaik bagi konsumen.

RSSI

RSSI merupakan teknologi yang digunakan untuk mengukur indikator
kekuatan sinyal yang diterima oleh sebuah perangkat wireless. Namun,
pemetaan langsung dari nilai RSSI yang berdasarkan jarak memiliki banyak
keterbatasan, karena pada dasarnya, RSSI rentan terhadap noise, multi-path
fading, gangguan, dan lain sebagainya yang mengakibatkan fluktuasi besar dalam
kekuatan yang diterima. Semakin besar nilai RSSI, semakin kuat sinyalnya. Jadi,
ketika nilai RSSI direpresentasikan dalam bentuk negatif (misalnya -100),
semakin dekat nilainya dengan 0, semakin kuat sinyal yang diterima.

Sedangkan hubungan antara LoRa dan sensitivitas yang tersedia untuk
setiap kecepatan data (spreading factor atau SF) dapat dilihat pada tabel
dibawah ini seperti yang telah dijelaskan oleh Semtech mengenai device LoRa
SX1276. Untuk contoh, diasumsikan bahwa bandwidth LoRa ditetapkan pada
125 kHz.

SNR

Signal-to-Noise Ratio (SNR) adalah perbandingan antara kekuatan sinyal
dengan kekuatan noise yang biasa dinyatakan dengan desibel (dB). Semakin
tinggi angka SNR maka semakin baik karena terdapat lebih banyak sinyal
informasi yang berguna daripada noise (informasi yang tidak diinginkan). Rasio



signal-to-noise, bandwidth, dan kapasitas kanal dari kanal komunikasi
dihubungkan oleh teorema Shannon-Hartley. Rasio yang lebih besar dari 0 dB
atau lebih tinggi dari perbandingan 1:1, menandakan lebih banyak sinyal
daripada noise.

Seperti yang diketahui, dalam konektivitas jaringan nirkabel, para ahli
menyatakan persyaratan SNR minimal 20 dB. Namun, berikut ini adalah
persyaratan nilai SNR:

= 5 dB - 10 dB: berada dibawah tingkat minimum, karena tingkat noise

hampir tidak dapat dibedakan dari sinyal yang diinginkan.

* 10dB-15 dB: nilai minimum yang diterima untuk membuat koneksi yang

tidak dapat diandalkan.

= 15 dB - 25 dB: biasanya dianggap sebagai tingkat minimal yang dapat

diterima untuk membangun konektivitas yang buruk.

= 25 dB sampai 40 dB: dianggap baik.

» 41 dB atau lebih tinggi: dianggap sangat baik.

3. PERALATAN YANG DIGUNAKAN
Hardware
- 1 LoRaWAN
- LoRaWAN Gateway Antares
- 1 PCatau laptop
- 1 kabel serial (USB to mini USB)

4. RANGKAIAN

Gambar 3. Gambar rangkaian

Node LoRaWAN dihubungkan pada PC atau laptop pada serial port dengan
menggunakan kabel USB.

5. LANGKAH PERCOBAAN
a. Koneksi ke Antares
1. Registrasi akun ke antares: https://antares.id/



https://antares.id/

2. Klik Sign Up
3. Registrasi dengan email.

& ANTARES

Register

Create your account

L zen v
@  zenhadi@gmail.com v
) esseresses @

Create Account

Already have an account? Login

4. Terdapat verifikasi email, dan klik CONFIRM EMAIL

e\‘- ANTARES CONTACT / ABOUT

Hi zen,

Thanks for registering at ANTARES. Please aclivate your account by clicking

CONFIRM EMAIL

at this button below.

5. Lakukan login ke antares

& ANTARES 60T Main Website

Login :
Sign In to your account Slgl'l up
Are youin need of an enabler for your smart
home, smart city, industrial IoT, etc.? Connect all
your loT Devices to the real loT Platform,
ANTARES.

@®  zenhadi@gmail.com

[ — @

.

Not receiving verification email? Resend email

6. Aplikasi antares

< C @ consoleantaresid/dashboard/overview Qe x Ex»06O
& ANTARES
GENERAL Home / Overview
.
S Applcations =z D
88 Widgets 2 2 0
APPLICATIONS Devices usERKEYS
Documentation &
£ Account
loT News
& UserKeys

Embedded DevOps fir Industrial loT Security: Hack i chi
das Internet of Things How to Protect c it
Connarted Machinas Runoe Mora Than Fuer




b. Buat Aplikasi di Antares
1. Buat Access Key terlebih dahulu
& ANTARES
) Overview
& Applications

88 Widgets

Documentation &

£ UserKeys
Change Photo
Access Key (1D:passwera)
Key
Youdon't have access key. Get access key now.
v
Hasil:
Access Key (ID:pazsword)
Key
a 6cbe0280932de37c:f2a671de0dbd8404 (i3]

Copy paste di notepad: Access Key

2. Buat aplikasi

& ANTARES
GeneRAL Home / Applications

€ Overview

88 Widgets Congratulations!
Let's create your first application.
Documentation

A Account =+ Create an Application %

& UserKeys

Hasilnya:
& ANTARES
GENERAL Home / Applications / Add Application

£ Overview
Add Application

Application Name:

88 Widzets

A SmartCityPENS \[ v
Documentation & -
Application ID
AL Account A Smart0l Va v
& User Keys Labels

For example (Type: Sensor

Name Value n

[si bagian Application name dan Application ID.



3. Tambah perangkat pada antares

Home / Applications / SmartCityPENS

SmartCityPENS N
e APPUCATIONy

Labels Hierarchical URI
https:/platfor

-id/SmartCityPENS [0

Non-Hiera

https:/platfi

[CAEGyQbyw9qT)-37%X9U [T

© How to Create Device via API

This app’s device is empty.

You can add a device like Arduino, Android, Raspberry, ESP 8266, NB-
10T, Orange Pi Zero, Node Red &

T

Hasil:

Add Device
Name
A SmartTemp v

[sikan: Name
4. Dapatkan API dari antares

. Smart-Temp [ &Data ][ @set Lo f SSavsor ]
i &Data || 25et LoRa" || 3 Subscribe
Hierarchical URI
htty latform.anta /~/antares-cse/antares-
ityPENS/Smart-Temp [
Non-hierarchical URI
https:/platform.antares.id:3443/~/antares-cse/ont-5vi_nx7kSsaFY3ck
© How to Send Data & © How to Subscribe to Device Data &
Data

Time (WIB) Resource Index (ri) Data

5. Setting dan pilih sebagai berikut



Set LoRa Device

LoRa Device Class (@)
O Class A ClassB @ ClassC

LoRa Activation Mode
O OTAA @ ABP

ABP Parameters

® Inherit O Custom

Application EUI

0000000000000001

Device EUI

Random 16 hexadecimal characters

Device Address

Random 8 hexadecimal characters

Network Session Key
6cbe280932de37c0000000000000000

Application Session Key
0000000000000000f2a67 1de0dbd8404

Are you sure you want to set this device as LoRa device?

Copy paste di notepad: Network Session Key dan Application Session Key

ﬁ" EETIi;t'TemP | & Data | |E|

LoRa.id Device Address Hierarchical URI

160cce5a [N https://platform.antares.id:8443/~/antares-cse/antares-

LoRa.id Device EUI id/SmartCityPENS/Smart-Temp [T

9bBacbfd20ddcedd [

LoRa.id Device ID Mon-hierarchical URI

Svi_nx7kSsaFY3ck [T https://platform.antares.id:8443/~/antares-cse/cnt-5vi_nx7kSsaFY3ck
LoRa.id Activation il

ABP M

LoRa.id Band

AS920-923 [W

Catat juga di notepad: LoRa.id Device Address dan Hierarchical URI

c. Install dan setting Postman untuk Kkirim dan terima data ke node LoRaWAN
1. Download postman: https://www.postman.com/downloads/

2. Buat akun di postman
Create Postman Account  sign i instead?

Email

zenhadi@gmail.com

Username

zenhadi

Password
...........
Sign up 10 get product updates, news, and other
marketing communications.
Keep me signed in

By creating an account, 1 agree 10 the Terms and Privacy
Policy

Create free account



3. Klik “+” di postman utk mencoba pengiriman data ke antares

Owarview http... @ CET hitps.. @ http... @ @ LLL] Mo Envircnment e @

Untitled Request ) save & o

oY

GET w 0
Params Authorization Headers (6) Body Pre-request Script Tests Settings Cookies

Query Params

KEY VALUE DESCRIPTION ees Bulk Edit

4. Rubah dan setting sebagai berikut:
a. Rubah GET menjadi POST
b. URL: copy data dari notepad untuk Hierarchical URI
5. Klik bagian Headers dan isi sebagai berikut:
a. X-MZ2M-Origin: copy data dari notepad untuk Access Key
b. Content-Type: application/json;ty=4
c. Accept: application/json

POST ~ https://platform.antares.id:844 3/~ fantares-cse/antares-id/SmartCity Surabaya/smart-temp?x-M2M-0 m

Params @ Authorization Headers (11) Body @ Pre-request Script Tests Settings Cookies
KEY VALUE DESCRIPTl ooc  Bulk Edit Presets -
X-M2M-Crigin c82be52fOfc1c518:543020f800397619
Content-Type application/json;ty=4
Accept application/json

6. Pada bagian Body ketik sebagai berikut:

POST e https:fiplatform.antares.id: 8443/~ fantares-cse/antares-id/SmartCity Surabaya/smart-temp?x-M2M- 0/ m

Params @ Authorization Headers (11) Body 'J Pre-request Script Tests Settings Cookies
none form-data x-www-form-urlencoded @ raw binary GraphQL JSON Beautify
1 [ |
2 “m2m:cin”; {
3 "con™: "I\ type\":\"downlink\", -\ "data\":\"relay_matiy"1"

|
L

—_—
=

7. Klik Send dan amati di website antares utk data yang dikirim
a. Dipostman



POST ~ https:fiplatform.antares. id:844 3]~ (antares-cse/antares-id/SmartCity Surabaya/smart-temp?x-M2M-01 m

Params @ Authorization Headers (11) Body @ Pre-request Script Tests Settings Cookies
Headers 8 hidden
KEY VALUE DESCRIPTl e  Bulk Edit Presets
X-M2M-Crigin c92be5219fc1c518:543020f80c397619
Content-Type application/json;ty=4
Accept application/json
Body Cookies Headers (8) Test Results @ 207 Created 238ms ©41B  Save Response -
Pretty Raw Preview Visualize JSON = O <
1 |
2 R
3 "cin_7CTHOPzwRPaklMxl",
5 antarss-cse/cin-7C7HOPzwRPakIMTI",
& : "Jantares-cse/cnt-T_PIg_JuT-gldixw",
7 t": "28220522T1420
8 t": "28220522T142003",
9 "st": @, “/
fullc] "cnf”: "text/pla 2
11 ‘ce"I 4B,
12 "con™: "I\t Vi "relay_mati\"1"
13 I
12 I

b. Diweb antares

B smart-temp

DEVICE A Sub:
LoRa.id Device Address Hierarchical URI
45f9cf2d [N https://platform.antares.
LoRa.id Device EUI id/SmartCitySurabaya/sma
a74313a55ba48525 [
LoRa.id Device ID Non-hierarchical URI
T_Plg_uT-qldéw [ https://platform.antares 3f~/antares-cse/ent-T_Plg JuT-gld1Xw
© Howto Send Data & © How to Subscribe to Device Data &
Data Y
Time (WIB) Resource Index (ri) Data
2022-05-2214:20:03 /fantares-cse/cin-7C7HOPzwRPakiMr)

"type": "downlink",
"data”: "relay mati” \/

d. Kirim data dari node LoORaWAN ke LoRa Gateway (antares)
1. Install board ESP32
a. Buka arduino IDE
b. Klik Tab File > Preference
c. Padatab Additional Board Manager URL input link:
https://dl.espressif.com/dl/package esp32 index.json



https://dl.espressif.com/dl/package_esp32_index.json

Preferences X

Settings Network

Sketchbook location:

C:\Users\zenha\OneDrive\Documents\Arduino Browse
Editor language: System Default ~ | (requires restart of Arduino)
Editor font size: 12

Interface scale: Automatic = 100 %%  (requires restart of Arduino)

Theme: Default theme ~ (requires restart of Arduino)

Show verbose output during: || compilation [ |upload

Compiler warnings: None

Display line numbers Enable Code Folding

Verify code after upload [JUse external editor

Check for updates on startup Save when verifying or uploading

[JUse accessibility features

Additional Boards Manager URLs: https://arduino.esp8266.com/stable/package_esp8266com_index.json ~
More preferences can be edited directly in the file
C:\Users\zenha\AppData\Local\Arduino15\preferences.txt

(edit only when Arduino is net running)

OK Cancel

d. Klik Tools > Board > Boards Manager
e. Input ESP32 dalam pencarian dan install esp32 by Espressif System
@ Boards Manage

Type All | [ESP32

esp32

by Espressif Systems version 1.0.4 INSTALLED

Boards included in this package:

ESP32 Dev Module, WEMOS LoLin32, WEMOS D1 MINI ESP32.
Maore Info

Select version ~  Insta

2. Install library Antares LoRaWAN
a. Akses link: https://git.antares.id/elvandry13/workshop-antares
b. Download library Antares LoRaWAN AS923-2

C @ gitantares.id/elvandryl3/workshop-antares 2 % P »0@ :

Menu Seart ab COENGRN Sign in / Register

Elvandry Ghiffary Rachman > workshop-antares

W workshop-antares @ % Star | 0

Project ID: 260

<16 Commits F 1Branch ¢? 0Tags [ 348 KB Files [ 399 KB Storage

master waorkshop-antares History Find file & {

,’F;v;i Merge branch ‘devl’ into 'master’ [«««
(3
LS

2

b7866dbf | [

Rauuf Ash

B README I No license. All rights reserved
c. Buka Arduino IDE pada tab Sketch, klik Include Library > Add .Zip

Library
d. Input Library ANTARES LoRaWAN AS923-2


https://git.antares.id/elvandry13/workshop-antares

(& Select a zip file or a folder containing the library you'd like to add X
Look in: | libraries v FerE

B antares-esp32-http zip
B antares-esp8266-http.zip
i LoRaWAN-Arduino-Library zip) v"

-

Recent I...
4]
Desktop
Doume...

This PC

Network

File name: LoRaWAN-Arduino-Library.zip [ open
Files of tye: | ZIP files or folders G

e. Cek LoRaWAN: File > Examples > Antares LoRaWAN

@ sketch_oct13a | Arduino 1.8.16
File Edit Sketch Tools Help

New CtrieN

Open 0

Open Recent >

Sketchbook >

.

Exbmples : Robot Control >

Close CtrisW

& Culés Robot Motor >

¢ S0 >

Save As.. Ctrl+Shift+S
Servo >

Page Setup  Ctrl+Shift+P SpacebrewYun i

Print Ctil+P Stepper >

Preferences  Ctrl+Comma CILEE i
RETIRED >

Quit Cul+Q e A
EEPROM ’
SoftwareSerial >
SPI >
Wire ?
Antares LoRaWAN 3 ABP_HEX_CLASS_A_DISCOVERY KIT_B-LO72Z-LRWAN1
Arduinolson > ABP_HEX_CLASS_C_DISCOVERY KIT_B-L072Z-LRWAN1
Blynk b Debug-LoRa
DHT sensor library > send-class-A-ABP
HardwareSerial RS485 > send-class-A-ABP-HEX
RadioHead-master L] send-class-A-OTAA
TinyGPS+ + > send-class-C-ABP
UniversalTelegramBot > send-dass-C-ABP-HEX
INCOMPATIBLE b send-dass-C-OTAA

3. Hubungkan LoRa modul ke PC melalui kabel USB sesuai gambar 3.

& sketech_oet13a | Arduing 1.8.16
File Edit Sketch Toals Help

Aute Format Cirl&T
Archive Sketch
skatch_oct13 Fix Encoding & Reload

Manage Libraries Ctel +Shift+1
pur Serial Monitor Cirl # Shaft = M
Serial Plotter Citrl # Shaft«L

WiFi107 f WiFiMINA Firmveare: Upcater

put Board: “Arduino Uno® »
Piort 2 Serial ports
! Get Board Info COMS
Programmer: “AVRISP mikdl® 2

Burn Bootloader

Jika belum terhubung, install driver CH341



4, Pilih ESP32 Dev Module

B [® ESP32 Dev Module
ESP32 Wrover Maodule

Houme Share Vi
ESP32 Pico Kit
o - S— - .. - =
@ send-class-C-ABP | Arduing 18.16 = Tiny P
MagicBit
Fika Edit Sketch Toals Hel
ik E wtch Tools Help : Turta loT Node
Auto Format Ctrl+ T TTGO LoRa32-OLED Vi
Archive Sketch TGO ™
send-class-C: Fix Encoc-.ng Sl Raload MinaBox CW02
$inclu T HIEDE SparkFun ESP32 Thing
Serial Monitor Ctrl+ Shifts M u-bilox MINA-W10 series (ESP32)
Serial Plotter (Ctrl+Shifr+L Widora AIR
WF107 / WENINA Firmmare Lpdater e
| = Nano32
. aﬁm::spﬁ D::,:;OM ) Boards Manager. oS
Upio o 9216007 4 Asduing AVR Boards
f:‘ J'F ; 'P-lilﬂ".iH {WViFiBT)" iy - J OLIN D3z PO
. WE/BT) b 1 dhsina 3
Flalh F“""""“‘ “BOMH: '. I :S_;Hf- B 263 HEMGS LR
ch Frequency: Z 3 < y 3
uency: e e Dongsen Tech Pocket 32
Flash Made: "QI" *
Wehlos WiFIEBlustooth Battery
Flagh Size: “4ME [32Mb]"
ESPead?
Partition Scherme: “Default 4MB with spiffs [1.2MB APP/1.5MB SPIFFS)" >
i Naduing Quantum
Core Debug Level “None* %
PSRAM: “Disabled™ 5 -
i
" = Hamkbill ESP32 Dev
ot &
. Hornbill E5F32 Minima
Get Board info
£ = FireBeetle-ESP32
v

Programener
Bum Bootloader

5. Lakukan interkoneksi modul LoRa dengan GW dari: File > Examples >
Antares LoRaWAN > send-class-C-ABP

© sketch_oct13a | Arduino 1.8.16
File Edit Sketch Tools Help

New CtriieN
Open Ctd:0
Open Recent >
Sketchbook >
5 a
Bamples Robot Control >
Close CtrlsW
2 Robot Motor ?
Save CulsS
SD >
Save As. Ctrl+Shift+S
Servo 4
Page Setup  Ctrl+Shift+P SpacebrewYun
Print Culsp Stepper ’
Preferences Ctrl+Comma {amioo ?
RETIRED »
Quit Cul+Q
Examples for Ardu
EEPROM >
SoftwareSerial ’
SPI >
Wire >
Antares LoRaWAN 3 ABP_HEX_CLASS_A_DISCOVERY KIT_B-LO72Z-LRWAN1
Arduinolson ¥ ABP_HEX_ CLASS_C_DISCOVERY KIT_B-L072Z-LRWAN1
Blynk » Debug-LoRa
DHT sensor library » send-dass-A-ABP

HardwareSerial RS485
RadioHead-master
TinyGPS+ 4
UniversaiTelegramBot
INCOMPATIBLE

send-class-A-ABP-HEX
send-class-A-OTAA
send-class-C-ABP
send-class-C-ABP-HEX
send-dass-C-OTAA

6. Lakukan setting seperti berikut ini di file tersebut:



] interval 10000; 10 s interval to send message
1 previousMillis 0; will store last time message

counter = 0; / message counte

myStr[50];
outstr[255];

e recvStatus 0;

Lakukan copy paste dari file notepad yang menyimpan data berikut:
*devAddr = device address

*nwkSKey = Network session key

*appSKey = Application sesion key

Lakukan Compile & Upload dengan tampilan seperti gambar diatas.
Untuk melihat proses pengiriman di modul LoRa, pilih Tools > Serial
Monitor dan atur baud rate: 115200

@
Send
A oENUINg . OULE CUOICEL—Z£ N
> fport: 3 Ch: 3 Freg: S22200000
> Sending: Lora Counter=3
> fport: 5 h: 2 Freg: 521200000
> Sending: Counter—4
fport: 5 0 Freq: 921400000
> Sending: Lora Counter-5
> fport: 5 Ch: 3 Freg: 921800000
> Sending: Lo Counter-6
fport: 5 » 3 Freg: 521400000
> Sending: Counter-7
fport: 5 Ch: 4 Freq: 322000000
> Sending: Lora Counter-8
fport: 5 <Ch: 5 Freq: 922200000
W
[w] Autoscroll [v] Show timestamp Newline w| 115200 baud ~  Clear output
— -

Lihat data yang diterima di Antares melalui websitenya. Jika belum muncul
datanya, bawa modul ke luar ruangan agar bisa terhubung dengan LoRa
Gateway dari Antares.
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Dari hasil yang diterima terdapat banyak informasi yang bisa didapatkan,
seperti nilai SNR, RSSI dan delay.

HASIL PENGAMATAN
1. Lakukan pengiriman data dari node LoRa pada gateway LoRa sebanyak 5 kali
dengan lokasi yang berbeda-beda
2. Catat data yang dikirim, data yang diterima, SNR dan RSSI pada tabel dibawah ini

No Data dikirim | Data diterima SNR RSSI Delay

G| | WIN (=

TUGAS
Ulangi langkah untuk hasil pengamatan dengan mengirimkan data yang bervariasi dan
memiliki panjang data berbeda, kemudian catat juga nilai SNR dan RSSI yang didapatkan.



